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Introduction

In this course, you will gain a greater understanding of and appreciation for the financial capabilities of Excel. Managing Financial Data with Excel will:

· Introduce you to some of the basic financial capabilities of Excel.

· Give you a footing in some of Excel's more advanced financial features.

· Open the door to Excel features often overlooked in the financial world.

· Cover all components needed to gain a comprehensive skill-set in using Excel in today's globalized economy.

It is our hope that, by the end of this course, you will be well on your way to becoming a financial pro using Microsoft Excel. 

Enjoy.
Protecting Workbooks in Excel

Beyond protecting worksheets themselves from having incorrect data inputted into the wrong places, Excel provides an entire array of protection functions preventing the wrong people from accessing various aspects of your workbook. 

Excel allows users to protect the opening of workbooks, the editing of workbooks, or the editing of certain aspects of workbooks and/or worksheets. 

With Excel protection features, you have every ability to allow who you want to access what with your workbooks and worksheets. 

For our current example, we'll stick with the basics. We'll set a password to be used when opening up a workbook. 

[image: image103.emf]


1. In our sample worksheet, click on File, then Save As. 

We now have our Save As dialogue box

[image: image1.emf]


[image: image104.emf]

2. In the Tools drop-down menu at the top right side of the dialogue box, select General Options.

[image: image105.emf]


It is in the Save Options dialogue box that you can now set a password to open up your workbook. 

*Note - this same dialogue box can be used to create a password in order to modify a workbook, or to create a read-only option for using the workbook. 

3. Type a password in the Password to open field, then click OK. 

4. Excel will ask you to retype the password, do so, then click OK. 

* Make sure that you remember you password. Even the Excel dialogue box warns you that you will not be able to access this workbook again without it. 

Now we're back at the Save As dialogue box. 
5. Choose a name for your workbook, as well as a file folder on your computer to save it in, then click on Save.

You now have workbook saved on your computer that can only be accessed by password. 

It's an important feature for financial documents involving sometimes sensitive data meant for certain eyes only, isn't it?
A Financial Spreadsheet Essential: Data Validation
It's one thing to create a good spreadsheet. It's another to make it usable in a setting where more than one person will use it. 

Whether it be a form to fill out report card grades for teachers, or an inventory form to be used by an entire warehouse department, setting up worksheets to be used over and over again, and entering the same data over and over again, is a skill-set that most Excel users should have — but don't. 

This is particularly true in the financial world. The kinds of data used can be limitless. But some types of spreadsheet presentations requires that the data inputted be limited to a certain type — whether it be numbers with a set amount of decimal places, or proper names not exceeding a certain length. 

What data validation in Excel does is allow you to set the terms by which data is entered into the worksheet. 

Not only that, but Excel gives you options in terms of how you go about doing that. 

You can do it with a drop-down menu. You can allow an error but provide a warning. You can disallow the error and only allow an input once the correct format is used. 

The options are limitless. The effect is focused worksheets that serve your purpose and that of your organization, too

A blank worksheet can serve as a good starting point to demonstrate the data validation function of Excel. 

[image: image106.emf]


1. Type "Parts" in cell A1. Then select cell B1.

[image: image107.emf]

 

2. Click on Data, then Validation. 

[image: image108.emf]

3. Choose the Setting tab in the Data Validation dialogue box.

4. Click List in the Allow: list.

5. In the Source field, type: "pistons, valves, sunroofs"

6. Then click OK

In our sample worksheet, selecting cell B1 now creates a drop-down menu containing only the choices to be allowed in this cell. 

[image: image2.emf]


To test if the validation works, try inputting something other than the three options we have set for the cell. As you can see, a warning dialogue box appears telling us that the cell contains data validation rules that must be followed. 

[image: image3.emf]


This is a simple but clear example of data validation at work. 

We have set up the worksheet so that only certain kinds of data can be inputted in selected cells. This is exactly the kind of utility you want to have when dealing with financial spreadsheets that contain specialized data and information. 
Budget Primer: The IF Function

Any budgeting process first starts with zero. In other words, at the beginning of the budget cycle, you have yet to bring in revenues or income. 
This is where Excel's IF function can come in handy. 

The diagram includes the profit and loss summary of a sample company budget. 

[image: image4.emf]


When calculating the gross margin as a percentage of revenue, the IF function allows you to start with zero revenues without ruining the percentage calculation. 
[image: image109.emf]

 
Cell C9 contains our IF formula: =+IF(C5=0,0,C7/C5)
Like all Excel formulas, it begins with the equal sign, followed by Excel's initials for the function in capital letters, followed by parentheses that include the Excel arguments for that function, which are separated by commas.
For the IF function, the first comma is preceded by what's called the logical test. In this example, the logical test is C5=0. The second comma is preceded by what's called the value_if_true. The second comma is followed by the value_if_false.
[image: image5.emf]


In other words, in this profit and loss summary, if revenues equal zero, then the gross margin percentage will equal zero. If revenues don't equal zero, then gross margin percentage becomes gross margin divided by revenue. 
[image: image110.emf]

If you were to try the gross margin calculation without the IF function, by simply dividing C7 by C5 — when C5 revenues are zero — you would get "#DIV/0!" in the C9 gross margin row. 
                             It wouldn't work!

This is where something like the IF function lets you get around some of the simple pitfalls of basic math. It can also be used for various financial calculations where the IF function's logical test can help you manipulate the worksheet presentation for your benefit.

Absolute, Relative, and Mixed References At a Glance

Cell C9 of our previous exercise can also serve as an example of how to use absolute, mixed, and relative references in Excel. Being able to do so, and knowing the difference between them, can make all the difference in the world in creating functional financial spreadsheets for your business or organization.

[image: image111.emf]


1. Let's select cell C9. 

The formula for that cell contains references to other cells. These references are crucial in order for the formula to carry out its requested calculations.

[image: image6.emf]


In this formula, cell C5 is our first reference. 

2. Highlight reference C5 in the formula bar. 

[image: image7.emf]


3. Now press F4.

As you can see, a dollar sign, $, appears before both "C" and "5" in the reference, so that it looks like "$C$5". 

[image: image8.emf]


The dollar sign indicates an absolute reference. It means that, no matter where you cut and paste this formula, the reference will remain "C5". If the dollar signs are left out, then the reference is relative, and it will change as you move the formula to another cell. 

By highlighting C5 in this formula, and using F4 to toggle through the options, Excel will vary the reference options. 
A mixed reference is when one row or column in the reference is absolute, while the other is relative. "C$5" is a good example of a mixed reference. 

Naming Ranges
This current worksheet also gives us a quick opportunity to examine the importance of naming ranges. 

1. Select the range C5:H5, which is the Revenue category in our worksheet.

[image: image9.emf]


2. Now go to the name box, which is located to the left of the formula bar. It normally contains a cell reference. In the diagram, that's "C5".
[image: image10.emf]


3. Type in "Revenue" in the name box and press Enter. 

[image: image11.emf]


If you click on the worksheet again, the Revenue name will disappear. However,

4. Type in "Revenue" in the name box again, press Enter, and the range will automatically be highlighted for you again.

Naming ranges like this can make manipulating Excel formulas much easier. In essence, what we've done is give an entire range of date one reference. This one reference can act as a substitute for a number of cell references and ranges, which makes using Excel formulas and procedures that much easier. 

Budget Follow-Up: Scenario Analysis
Part of a good budgeting process involves taking into account what could happen if things go better than expected, and what could happen if things go worse than expected. 
The following is a scenario analysis. It takes into account factors that drive a budget one way or another, as well as other impacts on revenue. 
[image: image12.emf]


As with the previous budget example, the IF function allows you to calculate percentages even if your numerator is zero. This is what cell D24 shows us. 
[image: image13.emf]

   [image: image14.emf]


What this scenario analysis also showcases is the importance of order of operations in Excel formulas. 
Let's take a look at cell B24, where the formula is: =+B21*(1+SUM(B15:B19)). The output of this formula can be confusing unless the formula is inputted correctly.
In this instance, to get an answer for cell B24 (best case scenario revenues), Excel multiplies B21 (base case scenario) by one plus the sum of columns B15 to B19 (impacts on revenue). 
B21:

[image: image15.emf]


B15 to B19:

[image: image16.emf]


To get B24:
[image: image17.emf]


As in all Excel formulas, the order of operations is crucial. Excel adds, subtracts, multiplies, and divides according to what comes first, and what's separated by parentheses. 
The scenario you want to avoid with your scenario analysis is a formula whose order of operations is off. It will leave your entire analysis off, too. 

At-A-Glance Conditional Formatting

Excel's Conditional Formatting utility can be used to format a spreadsheet based on conditions you set. In essence, it can be used to "red flag" items based on their status.

In this example, we'll use an operations performance spreadsheet to essentially tag items above and below a certain amount in one column. 

[image: image18.emf]


[image: image112.emf]


1. Select the cells to be formatted, which in this case is the range: E2:E9. 

2. Go to the Format menu, then click Conditional Formatting.

[image: image19.emf]


We should now be seeing the Conditional Formatting dialogue box.

[image: image20.emf]


3. In the second field from the left, select "greater than".

4. In the third field, enter "50".

5. Now click on the Format button.

[image: image21.emf]


6. Under the Font tab, select the green color, then click OK.

7. Now click Add in the Conditional Formatting dialogue box.

This gives us our chance to add a second condition.

[image: image22.emf]


8. In the second field from the left, select "less than". Leave 50 in the third field.

9. Pick red for the formatting color using the same procedure used for green the first time.

10. Now click OK on the Conditional Formatting dialogue box. 

[image: image113.emf]


As you can see, all the items in the Units Shipped column are tagged according to amount. Items above 50 are in green. Items less than 50 are in red. 

Error Check in Excel

There's a quick way to use an Excel conditional formula in order to perform error checking within a worksheet. 

Let's do this by using a simple spreadsheet containing sales figure for two years. 

[image: image23.emf]


What we want to do is make sure that the last column adds up properly. And, when it doesn't, an error message will show up. 

We will use cell E6 to set up our required formula, which is: 

=IF(SUM(D2:D5)=D6, "","Error")
This formula essentially tells us that, when the sum of range D2 to D5 is equal to cell D6, nothing will be displayed in cell E6.

However, if the range and cell don't equal each other, then the word "Error" will appear in cell E6.

So,

1. Let's enter the formula in cell E6.

[image: image114.emf]


As you can see, "Error" now appears in cell E6. We can improve upon this by making this alert appear red. 

[image: image115.emf]


2. Select cell E6.

[image: image116.emf]


3. Go to the Format menu, then Cells. 

4. Under the Font tab, select red in the color field. 

[image: image24.emf]


5. Then click on OK in the Format Cells dialogue box. 

As you can see, the error message now appears in red.

[image: image25.emf]


One more thing. Let's see what happens when we have the correct total in cell D6.

6. Enter "2323" in cell D6.

The error message is now gone, and a perfect example of Excel's error check abilities has now been demonstrated. It's a neat tool to use to make sure that important data is inputted properly into your workbook. 

Query vs. Lookup

Excel provides at least two different ways of sorting through database-like information: Query and Lookup. They both have their strengths and weaknesses, which we'll discover by looking at each separately.

Query

What Excel's Query ability does is essentially sort through an external database. 

1. In a new worksheet, click on Data, then Import External Data, then New Database Query.

[image: image26.emf]


For our current example, we'll use a Microsoft Access Database which we have access to on our computer. Any file with an "mdb" file extension will do.

[image: image27.emf]


[image: image117.emf]


Once you have found the database you want,

2. Select it, then click OK on the Select Database dialogue box.

The Query Wizard - Choose Columns dialogue box should now be on your screen.

[image: image28.emf]


For this particular database, we're interested in customers. So,

3. In the Available tables and column field, scroll down to Customers.

In the Customers category, we're interested in Customer ID, Company Name, and City, so select each of those, then add them to the Columns in your query field on the right. 

[image: image29.emf]


4. Now click Next on the Query Wizard - Choose Columns dialogue box. 

The Filter Data dialogue box should now appear. 

We want to limit our query to one city: Berlin. We do this by:

[image: image118.emf]


5. Select City in the Column to filter field.

6. Select equals in the left City field.

7. Select Berlin in the right City field.

Make sure the And button is selected.

8. Now click on Next in the Filter Data dialogue box.

The Sort Order dialogue box now appears. 

[image: image119.emf]


9. Select CompanyName in the Sort by field, and select the Descending button to the right of it. 

This means that our query will be sorted by company name in descending order. 

10. Now click on Next in the Sort Order dialogue box.

Which brings us to the Finish dialogue box. 

11. Select Return Data to Microsoft Office Excel, then click on Finish in this dialogue box. 
[image: image30.emf]


The Import Data dialogue box now appears with our worksheet. 

12. Make sure the Existing worksheet button is selected. The field should contain =$A$1, which is where we want to put this data.

[image: image31.emf]


13. Now click OK on the Import Data dialogue box. 

Voila! We now have the results of our query. There is one record in our database that met all our criteria. 

[image: image32.emf]


Lookup

Excel's Lookup function differs from Query in that it resorts to more traditional techniques of cutting through data. It does this by using database information within the workbook itself. It also does it by using what Excel is now famous for — the formula.

The advantage of using Lookup is that you don't need something like a Microsoft Access database file to use it. 

The disadvantage is that you have to manually configure the formula. You don't have recourse to fancy dialogue boxes with ready-made fields that make sorting data a matter of clicking and pointing with the Query utility.

We'll use this simple spreadsheet to demonstrate Excel's Lookup function.

[image: image33.emf]


As with all Excel spreadsheets, they become databases if they're organized into columns with headers located on the top row. That's what's been done to this spreadsheet. 

We'll use the VLOOKUP function to search vertically through the list, since most databases are organized vertically like this. 

We'll enter our formula in cell C7. 

Here it is: =VLOOKUP("barbara",A2:C6,2,FALSE)
The first argument is "barbara", which has to be in the first row to use this formula.

The second argument is the range A2 to C6, which contains the data in our little table.

The third argument is the column in the table to be used, which is the second one representing the age category. 

The fourth argument can be left blank, but we've entered FALSE to make sure the formula checks all items until it gets a match.

After entering the formula, we get the number 23 in cell C7.

[image: image34.emf]


So, we have used the LOOKUP function in this case to search through an Excel database vertically using specific sets of criteria. 

The Value of Money Using Excel

Interest is a bedrock of the financial system. It essentially attaches a cost to borrowing money. 

So it's not surprising that Excel possesses an array of formulas to specifically deal with this aspect of the financial world. 

In so many sectors of finance, manipulating values to take into account interest rates is crucial to doing business. 

Among the calculations Excel is programmed to make are: future value (FV), interest payment (IPMT), payment on a loan (PMT), payment on principle (PPMT), present value (PV), and many more basic and complex Excel financial functions.

In our current example, we'll deal with the present value (PV) function and demonstrate how it can be put to financial use. 

The worksheet displayed in a diagram contains a chart meant to answer the following question: Is it more cost-effective to pay $11,000 for a copier today, or pay $3,000 a year for the copier over a period of five years?
[image: image35.emf]


In order to answer this question, we want to know what the present value is of those $3,000 a year payments made for the next five years. 

So, we use Excel's present value formula.

Excel's PV formula is as follows: PV(rate,#per,[pmt],[fv],[type])
rate is the interest rate per period, which is located in cell D3.

#per is the number of periods in the annuity, which is located in cell D5.

pmt is the amount of the payment made each period, which is located in cell D4.

fv is the future value after the last payment is made, which is 0 in this case.

type refers to whether the payment is made at the beginning or end of a period. If it's the beginning, then the value is 1. If it's at the end, then the value is 0, or can be left blank. 

For this example, we'll assume that the payments will be made at the end of each year, so we'll use 0 for type. 

Cell D8 is where our the result of our calculation will be displayed. 

[image: image36.emf]


As you can see, the answer to our present value formula is -$10,814.33, which means we would pay that much out according to the factors assumed in our formula. 

So, we have determined that it would indeed be cheaper to make the annual payments for the copier than to make a lump sum payment of $11,000 now. 

Among the many utilities present in Excel, the ability to manipulate calculations involving interest rates is a powerful one. There are a wide ray of functions that Excel uses in this area of finance. Familiarizing yourself with as many of them as possible can only increase the power of your financial spreadsheet presentations.  

Excel as Database Software

In many ways, Excel is an example of database software. As long as you have lists of information organized into categories, you have a database. And the creators of Microsoft Excel keep this aspect of spreadsheets in mind when designing utilities for this versatile piece of software. 

The following is a perfect example of a makeshift Excel database — a kind created by countless Excel users without even realizing they're actually creating a database.

[image: image37.emf]


This example is essentially a table that includes lists of information organized by category. The categories are listed at the top, in the first row, while the information is listed below in columns under each category. 

In fact, this is an example of creating a database using Excel. 

However, it's one thing to have a database. It's another to do something with it. That's why Excel comes with the ability to manipulate database information in a way to make it much more useful to you the user. 

In our current example, we'll demonstrate how Excel's data entry forms are a perfect way to enter and filter information in databases. 

Excel Data Entry Forms

Excel Data Entry forms are a clean and simple way to enter and filter information into spreadsheets and databases. 

Unlike inputting information directly into worksheets, which can scramble all kinds of information with a click of a mouse, data entry forms allow you to make sure you know what you're doing before clicking on the "OK" button to finalize your operation.

1. Select any cell in our sample database, click on Data from the menu, then select Form. 

[image: image38.emf]


[image: image120.emf]


The Sheet 1 dialogue box should now appear.

We want to find sales values for Mary Davis above 4000. To do that, we:

[image: image121.emf]


2. Click the Criteria button.

3. Type in "Mary Davis" in the Sales Person field.

4. Type in "4000" in the Sales Value field.

5. Click the Find Next Button.

This gives us Invoice A005, which is the fifth line in our database, and the only one containing a sales figure above 4000 for Mary Davis. 

[image: image39.emf]


We can do one more thing with our data entry form. We can change the sales figure for Mary Davis if we like. 

Let's say we got her sales figure wrong. Instead of 5300, it's 5200. We can enter that directly into our form. 

6. Delete "5300" in the Sales Value field and, instead, type in "5200"

7. Now press Enter.

The value in the spreadsheet itself automatically changes from 5300 to 5200. 

Data entry forms are just one good example of how Excel makes data easier to work with, as well as databases more manageable for the financial world. 

Unlocking the Power of Financial PivotTables

The PivotTable is one of Excel's many utilities that turn a potentially nightmare task into something as easy as a few clicks of a mouse. 

What PivotTables essentially do is take a database of raw information and turn it into information you can manipulate easily, effortlessly, and with your specific goals in mind. 

It's why it's called a PivotTable. You can almost literally pivot the table in a way that reflects your data needs. 

The diagram is of a worksheet that includes hundreds of lines of repetitive data which, if left alone, you couldn't do much with. 
[image: image40.emf]


In comes the PivotTable utility!
In order to prepare your worksheet for a PivotTable, you need to organize it by column. Each category of information should have its own column, the header for which is located at the top, or in Row 1.

In this example, the information is organized into seven categories: Region, Product, Date, Customer, Quantity, Revenue, and Profit. Hence, each column in the worksheet has a header with the category serving as its title.
[image: image41.emf]


*Important: Each column must contain the same type of information: either text or numerical values. So, under company names are listed actual names of companies. Under revenue is listed numerical figures representing those values for each row. 
Also make sure that there are no hidden formulas or cells in your worksheet that could put a wrench in the creation of a PivotTable. 

Now your worksheet is ready for a PivotTable. 
To begin creating the PivotTable:
1. Select cell A2. 
2. From the Data Menu, select PivotTable and PivotChart Report.
[image: image42.emf]


3. In the wizard, the data you want to analyze is in the current Excel worksheet, while the kind of report you want to create is a PivotTable, as opposed to PivotChart Report. 
[image: image43.emf]


4. Click the Next button, which takes you to Step 2 of the wizard, which should have already guessed the range of data to be used for your PivotTable. Your entire set of data should now be automatically selected by Excel. 
[image: image44.emf]


5. Step 3 of the wizard asks where you want the PivotTable. Confirm that you want it in a new worksheet. However, before finishing the wizard, click on Layout at the lower left corner. This step can make organizing your new PivotTable much simpler. 
[image: image45.emf]


In the Layout dialogue box, there are grey buttons on the right representing the column headers on your worksheet. You can drag them into the diagram on the left to organize the PivotTable in the way you want. This can be changed later on if necessary. 
[image: image46.emf]


In this example, drag the Product into the column field and drag the Region button into the row field. Finally, drag and drop Revenue into the data field, where it will turn to Sum of Revenue. 
6. Click OK, click the Finish button in the wizard, and you'll have your new PivotTable — just like that!
[image: image47.emf]


As you can see, hundreds of lines of data are now organized into one small and manageable table. Product revenues are now organized by region. Totals for each product are given, as well as a grand total for all the products in every region.
[image: image122.emf]

All this was done automatically! No manual sorting! No confusing formulas! No endless manipulation of data!
The drop-down menus allow you to choose how many rows and columns in your PivotTable you want. 
[image: image123.emf]


You can use the PivotTable Field List to drag category buttons where you see fit in your PivotTable. You can play with the fields to create exactly the report you want. It's that simple!
Printing our PivotTable
Our PivotTable workbook can serve as a way to demonstrate how to print properly using Excel. We will select one area of our initial database to print, as well as the PivotTable that exists in the other worksheet in our workbook. 

This will demonstrate two things: printing certain views, and printing multiple worksheets in one workbook. 

1. In our database worksheet, highlight rows 85 to 105.
[image: image48.emf]


2. Go to the File menu, select Print Area, then click on Set Print Area.

[image: image49.emf]


What we've done here is create the view that we want for our print job. But we're not done yet. 

In that same print job, we want to add our PivotTable chart. To do that, 

3. Hold down the Shift key, and click on the worksheet tab at the bottom that has our PivotTable. 

[image: image50.emf]


Both our worksheet tabs should be in white, and are now ready to print. 

To see what we're about to print, 

4. Go to the File menu, then click on Print Preview.
One page will contain one view of our database, while the other page to be printed contains our PivotTable presentation — both in the same print job.
This nicely highlights two Excel printing abilities in one, and should serve as a doorway to explore even more printing options using Excel.  

The Next Step With PivotTables: Calculated Fields
Our current example is an already created PivotTable that contains two fields: Names and Amount Owing.

[image: image51.emf]


We want to add a third field: Sales Tax.

To do this, we will add a calculated field.

If the PivotTable toolbar isn't already displayed, go to the View menu, then select Toolbars, then select PivotTable.

1. In the PivotTable toolbar, use the PivotTable drop-down menu to select Formulas, then click on Calculated Field.

[image: image52.emf]


The Insert Calculated Field dialogue box should now be on display.

[image: image53.emf]


To name this field,

2. Type "Sales Tax" in the Name field.  
3. In the Formula field, type in ='Amount Owing'/10. 

This divides the Amount Owing field of our Pivot Table by 10. In other words, it applies a 10% sales tax on the amount owing.

[image: image54.emf]


4. Now click Add in the Insert Calculated Field dialogue box.

5. Then Click OK.
We now have a new Pivot Table that includes the Sales Tax total for all the items in it. 
[image: image55.emf]


The Analysis ToolPak, the Moving Average, and Inventory Analysis
The Analysis ToolPak is yet another example of how Excel can make an otherwise complex presentation as simple as a few clicks of the mouse. 

The ToolPak contains a set of  automatic tasks that perform certain analyses on certain kinds of data. 
Perhaps the most important rule to remember regarding the ToolPak is this: make sure you know what the type of analysis is, and that the data you have is suitable for that kind of analysis. 
In our current example, we will be using the moving average analysis on a company's inventory numbers. 
[image: image56.emf]


The moving average improves upon the simple average because it takes data points and produces a predictor of future data points. We know that inventory is suitable for this type of analysis because it contains numbers that fluctuate over a period of time, for which an average number is possible to calculate. 
1. The ToolPak can be found using the Tools menu, under Data Analysis. 

[image: image124.emf]


The new dialogue box contains a list of the kinds of analyses that the ToolPak can perform on your data. They range from statistical analyses like t-tests, to something more simpler like correlation. 

[image: image125.emf]


2. Select Moving Average, then click the OK button.
[image: image126.emf]


The Moving Average dialogue box should now appear. 
For the input range, you can simply select the range of data directly from the worksheet itself. 
For this example, we'll use the inventory statistics for product 1176, which is the first row. 
[image: image127.emf]


3. Move your cursor to cell B2, which is the first data point for that product, click and drag all the way across the row to cell M2. Release, and that range will now be automatically inputted in the Input Range field of the Moving Average dialogue box.
4.  In the interval field, type in "3", which is standard. The higher the interval, the more data points will be used, which gives you a smoother moving average. The opposite will happen with less intervals. 
5. The Output Range is where you want the results to start appearing. You can click on cell B14 directly and it will automatically be inputted into the Output Range field. 
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6. To present the moving average in a more visually understandable format, select the Output Chart option in 
the lower left corner of the dialogue box. 
7. Now click OK on the Moving Average dialogue box.
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Now we have our moving average. However, we're not done yet. While the graph is nice, and the pink line shows us the trend we wanted to see, it doesn't have any data points on it. Time to change that. 
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8. Right-click the first pink data point, which 
is right above "3" on the lower "Data Point" 
axis on our chart.
9. Select Format Data Series, which will 

open a new dialogue box.
10. We want to put labels on our data points, so click on the Data Labels tab, check Value in the "Label Contains" box, then click the OK bottom on the bottom right of the dialogue box. 
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This gives us our data labels, but they're not formatted properly, so we need to fix that, too. 

11. Right-click on one of the as-of-now garbled data points and select Format Data Labels.
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12. Under the Font tab, choose "8" in the size field. Under the Number tab,  choose "number" category with "0" decimal places. 
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Voila! We now not only have our graphical presentation, but we have actual numbers to use in order to predict future inventory trends. 
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This presentation is now easy to look at and provides valuable information for your organization.

The SUMIF Function Step 1
Excel's SUMIF function gives worksheet users a powerful tool to manipulate and present data. 

What the SUMIF function essentially does is:

1) Add values in your worksheet
2) Determine which values will be used based on another range of cells in your worksheet
It does in one step what other sets of simpler formulas accomplish using multiple steps. 

We'll first use a simple example to demonstrate how SUMIF actually works, then we'll move onto a financial example to further demonstrate its utility in the business world. 

In our first example, we have two columns of numbers: A and B. At the end of column B is where we'll use our SUMIF formula, located in cell B7.
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The formula entered in that cell is as follows: =SUMIF(A1:A6,165,B1:B6)
Before the first comma in the parentheses is the range, after the first comma in the parentheses is the criteria, and after the second comma is the sum_range.
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The range is the set of data for which you want to set the criteria. The sum_range contains the actual values for which you will make a sum.
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In this instance, the criteria has been set as 165. That means that rows in the first column, A, containing 165 will be used in determining what cell in the seconds column will be used to create our sum.
So, cells A2 and A6 contain 165, which means that whatever is in cells B2 and B6 will be used for our sum. In this case, they are the values 20 and 30 respectively.
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So, by entering our above SUMIF formula into cell B7, we get the value 50, which is the sum of 20 and 30, of course. 

[image: image63.emf]


Again, the criteria that was used to select cells in column A determine what cells to add together in column B. 

The criteria for column A was 165. This selected the values 20 and 30 in column B, thus giving us the sum we wanted.

There is one further trick to understand with the SUMIF function!

You can actually do away with the sum_range, and the exact same operations will take place but, instead, column A will be used to make the sum. 

This can be demonstrated by simply deleting the sum_range in the formula.
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If you do this, then column B now essentially gets ignored, and the formula will now add up cells in column A that contain 165. Again, they are A2 and A6. Adding them together gives us 330.

So, the SUMIF function not only allows us to add conditions to our sums, but it also allows us to tie those conditions to another set of data in our worksheet. 

Once you get the hang of it, it can add some serious power to your worksheet presentations. 
The SUMIF Function Step 2: Putting it to Use
Now that we have a basic understanding of the SUMIF function, let's put it to some financial use. 

In this diagram is a spreadsheet containing property values and the commissions to be earned upon the sale of those properties. 
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What the second half at the bottom of the diagram gives us are SUMIF formulas put to practical use. 
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Let's look at what's been done in cell A7. 

Cell A7 contains the SUMIF formula we want to use: =SUMIF(A2:A5,">160000",B2:B5)
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Cell B7 simply describes what we're trying to accomplish in Cell A7, which is a sum of all the commissions for properties with values over 160,000.
To do this, of course, we use the principles used in our basic SUMIF example of before. 

Let's look at our SUMIF formula: =SUMIF(A2:A5,">160000",B2:B5)
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What is this formula telling us again?
Well, it's telling us that the range we'll be using to select the sum is located in the range A2 to A5, which are our property values. 
[image: image66.emf]


The criteria we'll be using, then, are property values greater than 160,000. 
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These property values will select the commissions located in B2 to B5, which is the sum_range. They happen to be all the cells in our range except for B2. B3 contains 14,000, B4 contains 21,000, and B5 contains 28,000. 
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Their sum is 63,000, which is the value we see where our SUMIF formula is located in cell A7.
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So, with one use of a SUMIF formula, we have created a sum of commissions tied to a list of property values for which we have set conditions. 

The SUMIF function can be used to create sums based on criteria you set for another range in your worksheet. 
You can create sums of returns on investments based on different interest rates. You can create sums of receipts based on size of customer. You can create sums of business values based on the various forecasts of growth. 
The possibilities are literally endless with this neat little Excel function.

Macros For The Financial World

Macros have been an essential part of spreadsheet functionality for quite some time. They allow users to complete long and repetitive tasks with the click of a button.

There are essentially three ways to deal with macros in Microsoft Excel:
· You can create one by recording the actions that you want to form your macro

· You can write the macro code yourself using Excel's Visual Basic for Applications, or VBA
· You can import macro codes from outside sources and edit them for your own specific spreadsheets

Whatever method you end up using, the Microsoft Excel's macro capabilities — if used correctly — will greatly enhance your ability to assert control over your financial spreadsheets. 
Recording Macros

Perhaps the easiest and simplest way of creating a macro is by recording the steps you want to form your macro. 
To begin with, let's start with a sample spreadsheet that contains a simple list. In column A is a list of categories, in column B is the answer to those categories. 
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We'll create a macro that will erase all the contents of column B with the click of a button. We'll do this by setting up a recording of all the actions involved in erasing the contents of column B.

First, if it's not already there, we want to create a button on the toolbar that will allow us to create a button for our macro.
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1. To do this, select View, then Toolbars, then Customize.
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2. In the Customize dialogue box, click on the Commands tab, then select Forms on the left hand side. 
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3. On the right hand side, simply click and drag "Button" to a place on your toolbar where you want that button. It will now be used in the creation of our macro. 
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4. Click on the new button that's been created. Move the cursor into the worksheet without dragging it — it should now change into the crosshair symbol. 
5. Choose where in the worksheet the new button is to be located. Click on that location, and hold in order to adjust the size of the button.
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6. Once you release, a new Assign Macro dialogue box will appear.
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7.  Name the Macro, and create it for This Workbook in the Macros in drop-down menu.
You're now ready to click on the Record button on the right in order to start recording your new macro. 
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8. In the Record Macro dialogue box, you're now ready to click OK. 
However, before beginning, you want to make sure you're ready to perform the steps involved in the task to be associated with the macro. Otherwise, you might get the steps wrong and have to start the recording all over again.

9. Now Click OK in the Record Macro dialogue box.
The macro toolbar is likely to appear on your screen. This means that Excel is recording your macro, and you'll use the toolbar to stop the recording once finished. 
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Since we want our macro to erase all the contents in column B, that's exactly what we'll do now. 
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10. Select all the contents of column B by holding down the Ctrl key on your keyboard, then select all the cells in column B.
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11. Once you've done that, go to Edit, then Clear, then Contents Del, which will delete the contents of the selected cells. 

12. The task that we wanted for our macro is done, so it's time to stop recording the macro by pressing the stop button on our macro toolbar. 
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Our macro has been completed. We can test it by adding text to column B, then clicking our button — Voila! The contents of column B have been automatically erased with the click of one button.
There's one more thing to be done to make this task complete. We don't want our macro button to be named "Button 1", "Button 2", and so on. So, we'll rename it. 
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13. Right-click on the button. Choose Edit Text, then rename your button so that others using your spreadsheet will know what it's for. 
So, in a few simple and clear steps, we've created a button that can perform a set of more complicated steps with just one click. That's the beauty of macros. That's the beauty of recording macros for use in your financial spreadsheets. 

Although this technique is relatively straight-forward, its limitation lies in the fact you can only form macros for tasks you want to perform one time through. More complicated macros can be created by simply writing and editing code that does work far beyond the work of writing the code itself. This aspect of macros will be dealt with later in this workbook.

Another limitation of recording macros is that, to get it right, you have to make certain that you have your sequence of actions in order when doing the recording. Otherwise, you'll find yourself starting over again every time you make a mistake in recording the sequence you want for your macro.

Writing Macros
It's one thing to simply record a task you want to use as a basis for your macro. It's another to write the code that will do that task for you.

Writing code allows a user to enhance the functionality of  their macros. Unlike recording macros, where each task must be recorded step by step, code allows a user to map out the macro beforehand, and edit any aspect of it — all without worrying about sequence of tasks, or taking the time to actually do the tasks. 
Writing codes is essentially the next step to enhancing the power of macros.

However, you don't have to be an expert in writing code to actually write codes for macros in Excel. That's what Visual Basic for Applications (VBA) is for. 

VBA is Microsoft Excel's tool that allows users to write code for macros. We'll be using VBA as we perform our first bit of writing code for a macro. 
In order to write macros, the Visual Basic Editor needs to be opened in the workbook. 
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1. We do that by selecting Tools, then Macro, then Visual Basic Editor.
This opens up a completely new window containing the Visual Basic Editor.
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A module is essentially the storage place Excel uses for macros you create. We have to create a module in order to have a place to save our macro. 
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2. We do this by going to the Visual Basic Editor, then select Insert, then select Module. A module has now been created for the workbook.

This opens up a new window in the Editor, one in which we will start writing our sample code. 

3. Click inside this new window and type "Sub MyMacro", then press ENTER.
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Parentheses have been automatically inserted after the name of your macro, as has been the "End Sub" line at the bottom. 
This is the basic structure of macro codes written in Visual Basic. They start with "Sub" followed by the name of the macro, and end with "End Sub".

Blank lines are ignored by Visual Basic, as are any notes written that are preceded by an apostrophe. These notes appear in green so that they are easily differentiated from the rest of your code. 

Now it's time to insert the code for the macro we want to create. 
4. Between the "Sub MyMacro ()" line and the "End Sub" line, insert the following code exactly as written: MsgBox "My Macro Box."
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This code tells Excel to create a message box that is titled "My Macro Box."
5. Click on the "Sub MyMacro" line and press F5. This creates the desired message box with an OK button on it.
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6. Click the OK button to see our new macro in action.

With a knowledge of the kind of code that VBA uses, as well as the way it's to be structured, the functionality of creating macros increases exponentially. 

Writing code using Visual Basic opens up a whole new universe of performing increasingly complex tasks with the click of a button in Excel. 

It's not just about recording tasks into macros anymore. It's about designing macros with a few easy steps and some basic knowledge of the codes to be used. 

Writing More Complex Financial Macros - The Loop

Obviously, we want macros to do more than create simple dialogue boxes. We want macros to perform more repetitive and complex tasks as well. That's where the loop macros come in.
Loop macros essentially manipulate larger sets of data. They give users the power over ranges and lists in a way that manual operations, recorded macros, or basic code macros don't. 

In this exercise, we will use a sample worksheet in order to display the power of the loop macro by counting using the Do...Loop.
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Already inside this spreadsheet is the text for the code we want to cut and paste into our macro. As you can see, it starts with "Sub", followed by the name of the macro, followed by a pair of parentheses, and ends with "End Sub".

Let's take a look at this code:

x = ActiveCell.Row

y = ActiveCell.Column

z = 0

 Do While Cells(x, y).Value <> ""

    x = x + 1

    z = z + 1

 Loop

MsgBox "There are " & z & " rows in the current range."
We want this macro to count the number of rows in a range of data.
x will be the row that the loop is acting on.

x +1 is the next row.

z represents the number of counted rows, starting with zero when none has been counted.

The loop will count each row so long as there exist no blank rows. 

The last segment of the code will create the message box telling us how many rows have been counted. The ampersands allow it all to be combined in one message. 
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1. So, let's select and copy this bit of code, then click on cell C3, which has our first piece of data, "Brigitte", in a column of names.
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2. Now open the Visual Basic Editor by selecting Tools, then Macro, then Visual Basic Editor.

We want to create a new module for this macro, so 
3. Select Insert in the Editor, then Module. A new window for this module should open up, so that we can paste the code we copied from the worksheet itself. 

4. Now paste the code into the module window.
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5. To run the macro, click on the "Sub CountRows()" line, then press F5.
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As you can see, the macro does what it's supposed to do, which is to count the number of rows. Of course, there are six. 
Excel's "What If" Analyses

Excel contains an array of analyses, all of which are essentially designed to answer one question: What if?

Many Excel users don't even realize the extent to which they perform manual "what if" tasks all the time. 

Many of us have found ourselves playing around with formulas in a worksheet in order to figure out what would happen if we change something. We do this by changing inputs directly in our worksheet, right?

Excel's what if capabilities allow users to make these changes much more carefully and constructively outside of a workspace, thus saving us from errors, and increasing the power of a worksheet presentation.

We will currently examine four Excel what if analyses: Data Tables, Goal Seek, Scenario Manager, and Solver. 

Data Tables

Excel data tables essentially allow users to test and analyze outcomes on a large scale — how changing one aspect of a formula can affect the outcome of that formula. 

Our current example will involve the terms of a loan for a tractor, and we'll perform a one-variable data table exercise with it. 

1. Click on the OneVariableTable worksheet tab at the bottom of our workbook.
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It contains the information we already need to do our work. 
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2. Select cell E3, and type in =B11, which is the amount of the monthly loan repayment.

3. In cell F3, type in =B13, which is the total repayment.

4. Select cell G3, and type in =B14, which is the total amount of interest paid. 

5. Select the range D3:G9, which will be where our new data table figures will be located. 

[image: image83.emf]


6. Then select Table from the Data menu. 
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Since this is a one-variable table, leave the Row input cell empty.
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7. In the Column Input cell, click on the collapse dialogue button and select cell B5, which contains our original interest rate of 8.97%.

8. Click on the collapse dialogue button again to un-collapse the dialogue box, then click on OK. 
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As you can see, we now have a new table of figures. We have calculated the monthly repayment, total repayment, and total interest to be paid for various different interest rates, which is the one variable in our one-variable Data Table.

Goal Seek

Excel's Goal Seek utility allows users to find out what needs to change in an input to a formula in order to get a certain result for that formula. 

In our current example, we have a small chart that calculates the payments to be made on a loan. Those payments are calculated by a formula that exists in cell B4.
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We want the payments to be $1000, so we need to find out what interest rate will give us that total. And we'll do this by using Goal Seek. 
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1. Select Goal Seek in the Tools menu. 

The cell we want to set is B4, which contains our payment formula, and we want to set the amount at $1000. So,
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2. Type in B4 in the Set cell field.

3. Type in -1000 (again, it's negative because it's an amount we're paying out) in the To value field.

The cell that will change until we get our result is B3, which contains our interest. 

So,

4. Type in B3 in the By changing cell field. 

5. Now click OK.

Goal Seek tells us that an interest rate of 8.76% will give us the desired payment of $1,000.
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6. Click OK in the Goal Seek dialogue box, and we're done. 

Scenario Manager

Excel's Scenario Manager allows users to essentially create, view, and manipulate various scenarios within a workbook. As with some other what if analyses, in order to use Scenario Manager, your workbook must have at least one formula, as well as a number of criteria to be changed and manipulated. 

In our current example, we'll use Scenario Manager to figure out best and worst case scenarios for sample coffee sales. 
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Our formula of interest in cell G4, which is Total Revenue. 

The variable we want to change are cups needed to sell in order to meet that total revenue. Those values are marked in blue and located in cells D5, D9, and D13.

Now we're ready to use Scenario Manager. 
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1. On the Tools menu, click Scenarios.

2. Now click Add on the Scenario Manager dialogue box.

In the Add Scenario dialogue box,
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3. Type in "Best Case" in the Scenario name field.

4. In the Changing cells field, type in our variable cells, which are: "D5, D9, D13".

5. Now click OK in the Add Scenario dialogue box. 

The Scenario Values dialogue box appears.
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6. In the 1 field for reference $D$5, type in "150".

7. In the 2 field for reference $D$9, type in "225".

8. In the 3 field for reference $D$13, type in "125".

These are our values for our best case scenario. 

9. Now click the Add button, which allows us to create our second scenario.

Name this scenario "Worst Case" and repeat the above steps, except now use variable numbers: 50, 40, 30 — which is our worst case for cups sold. 

10. Click OK in the Scenario Values dialogue box when you're done.

The Scenario Manager dialogue box reappears, but this time it has scenarios in the Scenarios field. 
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11. Select Best Case, then click Show.

This shows our best case scenario, which gives us Total Revenues of $918.75.
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12. Select Worst Case in the Scenario Manager dialogue box, then click Show.

This shows our worst case scenario, which give us Total Revenues of $210.
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By setting up Scenario Manager to manipulate three inputs into one formula, we were able to create two scenarios to help us make a potentially important business decision. 

Solver

Solver is perhaps Excel's most powerful what if tool. That's why it's often referred to as a what if analysis on steroids. 

What solver does is allow more sophisticated criteria to be manipulated and inputted into one formula. 

*Solver can also be saved as a scenario to be used in Scenario Manager.
We will use a camping business spreadsheet as our sample.
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Our current problem is this: We want to determine the number of each type of camping kit that can be assembled from existing inventory while maximizing profit. 

We'll use solver to figure this out for us. 


1. Select Solver on the Tools menu. 

Total profits are want we want to maximize, so cell E15 is our focus and contains our target formula.

[image: image95.emf]


2. In the Solver Parameters dialogue box, select E15, which is also named TotalProfit, for the Set Target Cell field.

3. In the Equal to field, select Max, since we want to maximize profits. 

4. In the By Changing Cells field, enter the range C4:D4.
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We now want to add our constraints, so 

5. Click the Add button in the Solver Parameters dialogue box.

6. In the Cell Reference field, enter the range E6:E12.

7. In the middle drop-down menu, select <=.

8. In the Constraint field, enter B6:B12, which is the amount of inventory available.
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9. Now click Add. 

In the new Add Constraint Dialogue box:

10. Enter D4 in the Cell Reference field.

11. Select >= in the middle field.

12. Enter 3 in the Constraint field

[image: image98.emf]


This means that we'll have at least 3 kits assembled for our analysis.

14. Click the Add button in the Add Constraint dialogue box. 

Since we can't sell a partial kit, we want to add an integer constraint, too. 

We do this by using the new Add Constraint dialogue box again:

15. In the Cell Reference field, enter C4:D4.

16. Select "int" in the middle field.

The Constraint field will automatically have "integer" inputted in it and can be left as is. 
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17. So now click Add in the Add Constraint dialogue box. 

18. You can now click Cancel in the new Add Constraint dialogue box, which will take us back to the Solver Parameters dialogue box. 
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We're now ready to solve our problem. 

19. Click the Solve button in the Solver Parameters dialogue box. 
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If Solver says it has found a solution, and everything seems in order, you can click OK in the Solver Results dialogue box. 
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We now have a new spreadsheet that gives us maximized total profits based on more complex criteria changed in various places in the workbook. 

No wonder they call it what if on steroids. It's a lot of work. It's also an extremely potent financial tool once understood and used regularly.

Appendix
Templates

Excel templates have become a standard tool for Excel users. They are pre-made spreadsheets and workbooks already designed for a certain function. They can take the form of an invoice, balance sheet, or a wide array of other financial documents. 

You can access both pre-built and online Microsoft templates through the task pane in Excel.

Additionally, there are countless templates and sample files provided on the Internet.

They can also be customized for your specific needs. The tools and skills learned in this course should help you do that.
Excel Add-Ins

This workbook used two add-ins that might not be installed on your version of Excel yet. 

To install them, go to Tools, then Add-Ins, then check both Analysis ToolPak and Solver Add-in, the press OK.
Sample Database in Excel

For our Query exercise, a sample database was used that is already installed on Excel software. 

It should be located in 

C:\Program Files\Microsoft Office\Office11\Samples\Northwind.mdb
Recommended Resources

Microsoft Excel is truly one of the most widespread, versatile, and fascinating pieces of software available in the market today. 

To that end, the list of resources that can help anyone with this commonly available software can be endless. 

However, this course was in part designed with a few of these resources in mind. We have provided a list of these for you, as well as others that can make you an even better Excel financial pro than you will be after walking away from this course. 

These resources will cover most of what you have learned today. They can be used to relearn the basics or to further enhance your knowledge and understanding of Excel.

Let the process of learning guide your use of Excel and its financial capabilities. That's what this seminar is about.  That's what this list of recommended resources is about, too. 

Good luck!

Online

While additional resources for Excel are available in various forms, there is probably no better place to find them than on the Internet. With the point and click of a mouse, you can have access to countless Web sites containing information provided by qualified experts who know their Microsoft Excel and it financial uses. 

To that end, Microsoft itself tops our list of recommended Excel resources.

· http://office.microsoft.com/en-us/excel/default.aspx

There is probably no better additional resource to help further your understanding of Excel than Microsoft's Home Page for Excel. 

It is a comprehensive source for helping you with various aspects of different versions of Excel. It currently features the new 2007 edition of the software. 

It provides many of the help pages that you can actually access through the Excel software itself. It contains many articles written by experts expanding upon Excel's capabilities. It includes tutorials — some that include voice instructions — that help you with specific functions of Excel.

Don't be afraid to use the search function of this page, either. You can search specific versions of Excel. You can search for specific features of Excel. You can also search the database for financially related material by simply typing in "finance" in the search box provided. 

Excel is software that needs and deserves helpful resources. Microsoft has seen to that. Don't be afraid to make good use of them. 

However, the Microsoft home page for Excel is not a complete solution. Not all areas of the software are covered. You would probably need ten Web sites to do that. 

Some areas that are covered are done so with minimal comprehensiveness. Other areas covered are done so with excessive complexity.

That's why other resources available in the market can help round out a compressive and balanced list. That's what we have done for you with the following. Again, don't be afraid to make good use of these resources. They only serve to further enhance what you have learned today. 

· http://www.ozgrid.com/Excel/

Another comprehensive Excel resource that provides free and for-purchase Excel learning guides, templates, and sample files. 

· http://www.contextures.on.ca/tiptech.html

A comprehensive database of Excel tips, exercises, and FAQ's. If there's something you want to learn about with Excel, there's a good chance you'll find lots of information on it using this Web site. 

· http://www.meadinkent.co.uk/excel.htm

An excellent Web site that provides many exercises to help with an understanding of Excel's most useful and well known features. 

· http://spreadsheets.about.com/

An expert-guided site that provides many articles and how-to's on some of Excel's most important features. 

· http://help.cnet.com/microsoft-office-learning/

This site offers interactive tutorials regarding various aspects of Microsoft Office, including Excel. If interactivity is what you're after, then the CNET Learning Hub is a place you'll want to visit. 

· http://www.internet4classrooms.com/index.htm

Just type "excel" in the search box provided on the home page, and the site will provide a list of exercises for various features of Excel.

CD's/DVD's

· Unlocking the Secrets of Excel Formulas (Parts 1 and 2) by CareerTrack

A very helpful and informative tutorial CD-ROM that helps you get through some of the basic and more complex aspects of formulas in Excel.

· Excel 2007 by Apex We Media

A training CD/DVD, written by Cheryl Duncan, that covers everything you need to know about the latest version of this amazing piece of software. 

Books

· Excel Formulas and Functions For Dummies by Ken Bluttman and Peter G. Aitken
Uses real world examples to impart a thorough understanding of various Excel capabilities, including numerous financial operations.

· Principles of Finance with Excel by Simon Benninga

A thorough textbook that incorporates the latest teaching methods to deliver a much needed financially focused instruction program for Excel.  It also comes with a useful CD companion.
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